
+#Overview 
 

General 
This package is designed for use with Microsoft Windows 98/W2K/XP home or professional 
and higher. This manual assumes that you are familiar with the way Windows operates. If 
you're not, it is strongly advised to get familiar before installing the application. The same 
applies to playing Chess with this application. Both the manual and the program do not 
provide "tutorials". A basic knowledge of the Chess-game is required; however, a certain level 
of mastering the game is not needed! The program can be adjusted such that its level of play 
suits the player. 

About the manual 
The manual takes you first through the installation steps. Next, the control and usage of the 
program is described, followed by the use of the built-in Database. After these topics the 
advanced user gets his turn. The manual is not a tutorial, nor does it provide extensive 
descriptions of all menu-selections. On-line help is available when you require detailed 
descriptions of a menu selection. The manual provides guidelines to operate the application  
for both novices and experienced users. 
The procedures to follow are described step-by-step. It is assumed that you have a sufficient 
knowledge to control Windows. If you don't, study the Windows documentation where 
necessary. 
When a reference is made on using Windows, it is assumed that you use the UK/US-English 
version of Windows 
The following notations are used: 
• Keystrokes are printed bold and between brackets. For instance, pressing the Enter-key  

is printed as <Enter>, function keys as <F1>. 
• Combined keys are printed as <CTRL-F7> . 
• Menu selections are printed in bold e.g. Open file ... 
 
Any additional information and/or changes that could not be printed here can be 
found in the README.TXT file. This file can be browsed with the help of WORDPAD or 
NOTEPAD. After the installation the file can be read by clicking the README.TXT icon. 
Please read it carefully and make notes if needed. 
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+#Installation 
 

System requirements 
Before starting the installation, please check if your system adheres to the following: 
• AT class machine with Pentium processor or better. 

32 MB RAM. ( 64 MB Recommended ) 
Hard disk with at least  20 MB free space. 
VGA card with 256 color display or better. 
Mouse or pointer device. 

• The following programs must have been successfully installed: 
Window’98, Windows 2000, XP Home or Professional or higher 

Installation 
• The actual installation depends on how you have received the application, if you 

downloaded it from the Internet, just start the self-installing executable and follow the 
instructions 

• Did you get it on a CD-ROM follow the instruction included with the CD-ROM. 
• Follow the directions presented by the Setup program. When all questions have been 

answered, setup will copy all the selected files. When finished, setup creates shortcuts 
under the start menu, which contains icons for the various programs. 

• The next topics discuss the use and control of the application. 
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+#Using the program 
This section gives a general overview of how to use the program. 

Starting the program 
The default installation has placed a shortcut to the program under the Start menu. It depends 
on the specific distribution you have bought where this menu is. The standard Lokasoft 
version places it under:  Programs –> ChessPartner 5.4 –> ChessPartner 5.4 

When started, a splash screen is shown. The screen closes when the program is fully loaded. 

The menus conform to the Windows standard where possible; meaning that functions can be 
found where they usually can be expected; e.g. the first menu is the files-menu containing 
both file and printer choices. The Exit ... dialogue can also be found here. 

When a menu choice is not clear, you may press <F1> to get help on the current highlighted 
menu selection. As an alternative you may access the Help through the Help menu. 
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+#The Windows 
After the application has been started, and the logo screen has been cleared, several 
Windows are displayed, each having its own specific function. All Windows can be moved 
freely within the main Window. Also the size of each Window can be adjusted to your liking. 
Every time you exit the application, both the position and the size of all Windows can be 
saved so the next time you start the program your preferences are still in place! 

Clicking the X symbol in the top right corner of a window hides that Window. The window can 
be restored from the Windows menu. 

By clicking the right mouse button inside the Window, a pop-up menu is shown with the most 
common functions that apply for that Window. This may save some mouse movement and 
searching through the menus. Depending on the choosen layout more or less information 
windows are shown. A number of pre-defined layouts can be choosen from the layouts menu. 
Its also possible to define your own layouts. 

The Chessboard Window 
This Window shows the current state of the Chessboard and the player’s name. Moves are 
done by positioning the pointer over a Chess piece, holding down the left mouse button and 
dragging the piece to its destination. When the button is released, an attempt is made to play 
this move. When invalid, an error message is displayed and the piece is moved back to it 
original position. Alternatively click and release on the piece, a selection rectangle is shown, 
then click on the destination square to make the move. 

To castle, just play the King move, the Rook will be moved automatically. When a Pawn 
promotes, a dialog box appears allowing you to select the piece to promote to. En-passant 
moves are simply made by moving the Pawn. 

For faster move entry you may also double click on the destination field, if only one move is 
possible it is carried out immediately; otherwise a small menu pops up. If the smart move 
option is enabled only a single click is needed. 

The Moves List 
The moves list contains the list of moves played, optional the moves list can also display the 
players names and other games details. You can navigate the moves list using the toolbar 
buttons, or the navigation functions under the moves menu. 

 

By double clicking on a specific move, the game is moved to that position. The last played 
move that corresponds with the position on the chessboard is underlined. 

If you move back in the moves list, then perform a different move on the chessboard, a new 
variation is inserted in the moves list. This is indicated by a series of moves in between round 
brackets and in a different color. A variation can be deleted by double clicking the last move 
you want to remove, then click the red X button from the toolbar. 

Moves can be annotated with the Annotate function from the moves menu. To have the 
annotations visible in the moves list make sure the Show annotations option is selected in the 
general options. 
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The Clocks Window 
This Window contains the Chess clock for both White and Black players. The Clock can be 
displayed as a digital or analogue Clock. In digital display it will do a countdown (00:00:00) 
during tournament levels. Other levels of play will count upward. 

The status line also shows the clocks for white and black, always digital. 

The Book Window 
The book windows has two tabs, the moves tab and the books tab. In the books tab the 
moves are listed from the opening book(s) that are valid for the current Chess position. If 
there are no applicable moves, the Window is empty. Each move has a number of attributes 
with it. The score is the relative value of the move as seen from the player. The Type field 
indicates where the move came from, a question mark indicates that program will not play the 
move.  

The remaining 3 fields (White, Black, Total) are only valid when a book with statistic 
information is used, the field contains the number of times the move leaded to win for 
White/Black. The Total field contains number of times this move has been played. 

When learning is enabled the Learning column shows the learned score. This score is added 
to the moves basic score to aid in move selection. 

Double clicking a move in the list plays that move on the board.  

 

On the books tab the active opening books are shown, also shown here are some button to 
open/close books and to change the order of the books. 

The statistics Window 
The “thinking” process can be peeked at in this Window. In the View page from the options 
dialog you may define which details are shown here; e.g., main variant, score and search 
depth. 

Histogram Window 
This Windows visualizes the value of all positions in the game. You have the option of a Bar 
graph or Line graph display style. Use the view page from the options dialog to set your 
preference. 

Figure 1 

 
The vertical axis represents the score. It automatically adjusts to the maximum score during 
the game. Horizontally the last 50 moves are in view. By double clicking the left mouse button 
anywhere inside the histogram, that move position will be shown on the chessboard. The 
current position is also shown in the move list window. If the moves list contains variations 
then the histogram only shows the scores from the active variation. 



Engine Info Window 
This is a special window in which some engine can show additional information about their 
thinking process. Of the Lokasoft engines, the Rebel 12 engine is known to show the most 
information in this window. 

Database Window 
The database window contains a list of games from an open database.  More than one 
database can be open at the same time, each displayed in its own window. A game can be 
loaded from a database by double clicking on the line with the game. After the game is loaded 
the database window is minimized. 
You can use ‘drag and drop’ to move games from one database to another or drop a game on 
the chessboard window to load it. To start a ‘drag’ operation click on the most left gray column 
to select one or more games, then move the mouse a little bit until the cursor changes shape, 
now click the left button and start dragging. Dropping it on an other database window will 
move or copy the selected games, dropping on chessboard loads the game. Use the <ctrl> 
key to toggle between copy and move. 



+#Playing a game against the computer 
In order to play a game against the program, you must use the player’s definition to set Player 
/ Computer. Use the Players ... option from the Game menu to do so. You can choose to play 
the white or black pieces. 

When the player makes the first move, the Computer starts calculating a move. During this 
process the caption of the Chessboard Window shows that the computer is at play. In this 
phase you may check the statistics Window for the best variant found so far. 
When the computers time is up or the maximum search depth is reached, the best move 
found so far is played, and an optional beep or sound is generated. 
During the player’s turn, the Computer thinks about possible countermoves. This is an option 
that can be disabled and, of course, affects the strength of the program. 

Let the program play white 
If you have set the player definition to have the program play the white pieces and the 
computer had not yet make the first move, use the Start Game function from the Game menu 
to let the computer play the first move. Alternatively you may select Computer move from the 
Moves menu, this has the effect of swapping the players definitions. 

Taking moves back 
Only during the players turn is it possible to take back moves. When the Computer is thinking 
you must interrupt it by stopping the game or issue an immediate move. The latter can be 
established by the Immediate selection from the Moves menus or pressing <Ctrl-O>. Both 
cases will set the players turn. 
By pressing <Ctrl-T> or <Ctrl- > a single move is taken back. With the mouse the 
corresponding toolbar button can be clicked for the same action. When the Computer already 
has done a move, you must take two moves back. 

Playing the next best move 
During the opening phase of the game, when the program collects move from it’s opening 
book, you may have the choice of playing an alternate move. An appropriate menu choice is 
available and a keyboard shortcut <Ctrl-Z>. It is only available immediately after The program 
plays it’s move and the move came from the opening book or endgame database and there’s 
at least one alternate move available. As a result, the current move will be taken back and the 
‘next best’ is played. Next best moves are circular and you can rotate through all next best 
moves. 
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Let the program generate the players move 
During the player’s turn, you can let the Computer do the thinking for you by pressing <Ctrl-
C> or select Computer Move from the Moves menu. After the move is done, it is the players 
turn. 



+#Re-playing a Chess game 
In order to review a game you select Players... from the Game menu, and set it for Player / 
Player. 
Now the moves can be entered in any available fashion, the Chess brain will validate them 
however! With the navigation buttons you can move backwards and forward through the list. 
You may use the Analysis mode option to see what The program thinks of the game. See 
also the analyzing brain option. 

Annotating moves in the list 
By selecting Annotate... from the Moves menu or by pressing <Ctrl-K> you start a dialogue 
in which some text can be entered (up to 1024 characters). This comment will be connected 
to the move currently selected in the list. This is the move in the list displayed that is 
underlined. The annotation is automatically saved when the game is saved, it is displayed in 
the moves list. Its also possible to insert annotation moves symbols and annotation position 
symbols, these can be selected from their respective menus. 

The analyzing Chess Brain 
When you walk through a game, as discussed above, you have the possibility to let the 
computer analyze the moves. By setting the Analyzing brain option from the Chess Engine 
tab in the options dialog a move is calculated for the current position. The results of the 
analyses can be reviewed in the statistics Window. The extend of the analyses is unlimited, 
meaning that by allowing more time to analyze the better the calculated result will be. When a 
different move is selected, the analysis starts again for that specific position. 
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+#Setting the level of play 
A game of Chess can be played with various degrees of difficulty. The level can be set with 
the help of a dialogue. Select Level... from the Game menu, or press <Ctrl-N> to get the 
dialogue into view. The various levels are organized in folders, each folder containing specific 
types of levels. It is also possible to create you own customized levels. 
The following standard categories are available: 
• Fixed time for whole game 
• For beginners 
• Levels with time increment 
• Personal levels 
• Search depth levels 
• Search for checkmate 
• Special 
• Tournament level 
To select a level, just click on one of the folders and select the desired level and click the OK 
button. 
To create a new customized level, first select the folder where you want you new level to 
appear, then click the New Level button. This inserts a new level in the selected folder, now 
rename the level to your liking. Next step is to edit the just created level, click the edit button 
to start the level wizard. 
The wizard guides you through a number of pages allowing the setting of various options. 
Some additional functions can be accessed by right clicking on a level. The following chapters 
give a description of the various levels. 

Fixed depth 
With this level the computer will always calculate a move up to a certain number of ply’s. By 
selecting the appropriate radio button, you may edit the number of ply’s. Values ranging from 
1 through 30 are valid. Any other value entered will not be accepted by the Chess Brain, and 
an error message is returned if you attempt to set such a depth. 
The search depth entered is a so-called brute force depth. On top of this, the computer may 
do selective extended searches in some cases. The higher the search depth you set, the 
more time will be required to calculate the move. Given the exponential nature of the 
algorithm and the current speed of the hardware, a depth of 30 can hardly ever be reached. 

Fixed time per move 
Unless a Mate, Stalemate, or Draw occurs, the program will play the calculated move when 
the entered time limit has expired. Values of 15 seconds already produce a "do not under 
estimate me" opponent. 

Average time per move 
With this level, the computer will use the amount of time to calculate a move as an 
approximate. At certain stages in the game the time entered will be exceeded, but never more 
than five times the value entered. 

Time for the whole game 
You are given the opportunity to define the total amount of time available for the game. Each 
player gets that amount to finish the game. When a player fails to move before the clock 
returns to ‘zero’, he looses the game. 
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Tournament levels 
A tournament level uses a time limit in which a certain amount of moves MUST be played. It 
is split in two, when the first time limit expires and the required number of moves has been 
played, the second time limit and move count is activated, this is repeated when needed. 
Remarks: 
• When a digital clock is selected it runs backwards (countdown to 00:00:00). The 

Analogue Clock ticks forward from a preset position. 
• Each time the demanded number of moves is reached, the Clock is adjusted to the next 

time limit. 

Search for checkmate 
This level is meant to search for Mate positions, and is most likely used on end-games. The 
value you can enter, as a parameter is the search depth ranging from 1 through 30 

Levels with a timebonus 
This level operates just as the ‘Fischer Clock’ invented by Chess genius Bobby Fischer and 
accepted by the World Chess Union. You define the initial time available at the start of the 
game and the amount added after a move is played. A better spread of time and less change 
to end up in time trouble is the result. Also, you don’t have to adjust the clock as in other 
tournament plays. Two samples: 
basic time:   20:00 min. 5:00 min. 
bonus time:    2:30 min. 0:15 min. 
    ---------------- --------------- 
total after 60 moves  170:00 min. 20:00 min. 

Infinite time 
The infinite level is intended for evaluations. The computer will continue to calculate the best 
move for the given position forever until you force a move (<Ctrl O> or stop the game. Note 
that when there are still moves in the opening book these will be played instead of calculating 
one. 



+#Setting up a position 
If you wish to begin a game with a different position than the usual initial Chessboard, it will 
be necessary to put pieces at predetermined places. For that purposes an Edit position... 
function is available under the Edit menu. 
Positions (game without moves) can be saved in the database and, of course, be obtained 
from them too. Refer to the topic about using the Database(s). 
After you have selected the Edit position mode a toolbar appears at the bottom of the screen, 
this allows you to select the various pieces. The functions on the toolbar are also available 
from a context menu, which can be accessed with a right mouse click. 
Pieces can be moved to there required position, to add a new piece click the desired piece 
from the toolbar and drop it on the board. The is a function to move all pieces to their start 
position and to empty the board. 
When you are ready click the red V button to complete the setup. This brings up the castle 
right dialog, after confirming this dialog the setup is completed. 
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+#Printing 
The program gives you the opportunity to print games and diagrams. The following topics 
show you how to accomplish this. All the printing functions can be found with the File menu. 
Printing always occurs on the Windows default printer. 

Printing the game 
To print the current game, use the Print function from the file menu. To control what is 
printed use the General page from the options dialog. You have the choice to print the game 
including annotations, figurines, and diagrams. If the ‘Print diagram’ option is checked the 
game is printed with the current position inserted as diagram. 
During the preparation of the print job a small window is displayed, allowing you to cancel 
printing altogether. Other functions are disabled when printing. 

Advanced printing 
There are situations where the build in printing capabilities are not sufficient, for this reason 
there are a number of copy and paste functions to copy the game to you favorite word 
processor. 
To copy the contents of the moves list window to the clipboard, right click on the moves list 
and select the Copy function. This copies the entire game on the clipboard, including 
annotations, optional figurine fonts etc. 
To copy the chessboard window as bitmap to the clipboard, right click on the chessboard and 
select the Copy function. It is also possible to copy the chessboard as a figurine font, in that 
case select the ‘Copy game as font’ function. 
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+#Analyzing a game feature 
The program can analyze existing games from famous grand masters or yourself.  Its 
‘opinion’ can be read later on form the annotations in the move list and/or from a text file. The 
result consists of the move number, score and the variant as calculated by Rebel Tiger. From 
the Extra  menu, there are several analysis functions available: 
 

• Analyze Game(s): To analyze the current game, or games from one or more 
databases. 

• Analyze EPD:  To analyze test sets from EPD files. 
• Analyze position: Analyzes the current position with the option to either include or 

exclude certain moves.  
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+#The Chess database 

The program offers saving and retrieval of games and positions from a database. A database 
can be used as a reference and to keep and recall your interrupted games. It can also be 
used to collect famous Chess games, enabling you to "re-play" or analyze such games. 
A database may have various formats. Of course there is a native optimized format but also 
the Portable Game Notation (PGN) formats are supported. 
You are not limited to a single database, multiple databases may exist for various purposes. 
With the New database... dialogue, you can create as many as you want, while defining a 
global description of what the new database will contain. White the Open database 
....function a existing database can be used. Multiple databases can be open at the same 
time. All functions can be found under the Files menu. 
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+#Opening a database 
The dialogue presented is similar to opening a file and can be called with Open database... 
from the File menu. The following dialog lets you pick a file:  
 
Choose the database format (file type) you wish to select from and select one of the possible 
files listed. Upon selection, the Database description is shown together with info about the 
number of games etc. This helps you identifying databases more easily. Press the OK button 
to open the selected database.  There may be multiple databases open at the same time.  
Note; when you exit The program, the name of the current open database, if any, is saved. 
The next time you start, that database is opened automatically for you, saving some work. 
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+#Creating a new database 
You may create a new, empty database containing only a description of what the database is 
meant for or what it will contain. 
The file name that you have to provide may contain a drive letter and/or a path, the file 
extension determines the type of database that is created. (native or PGN). If no extension is 
given the extension for the selected database type is used. 
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+#Closing the current database 
You may close a database by closing the database window, click on the X in the top right 
corner. 
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+#Database maintenance 
As a rule, databases require maintenance, and so may these databases. With the Database 
maintenance sub menu some functions are available for repairing and compressing the 
current database. Depending on the selected database format some of these functions may 
not be available. The function always operate on the current selected database, if you have 
more then one database open, make sure the select the proper database. 

Information on the current database 
Each database has some comment text describing its contents. This text and the amount of 
games/positions saved and deleted can be viewed. The records marked as deleted can be 
permanently removed by compressing the database, with the result that the files take less 
disk space. 

Re-indexing the database 
Sometimes it may be necessary to re-index the database. An interrupted compression or 
abnormal program exit (Alt+Ctrl+Del ?) are just examples. In case you experience problems 
retrieving or saving games, you may also wish to re-index the database. 
It is possible to interrupt the re-index process but it is definitely not recommended. If you still 
wish to interrupt, use ONLY the button in the progress dialogue. 
PS. During the re-index, you can still play games, waiting for completion is not needed! 
 

Compressing the database 
Whenever a database has a lot of deleted games, it is recommended that you compress the 
database. This will not only save disk space, but also increases speed searching games. In 
case you have a game open that has not yet been saved, do so before starting compression. 
After compression you will not be able to save the game over the previous version! 
Hint: When disk space is scarce, always use the compressed format to save games. Refer to 
the normal format for a list of differences. 
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+#Loading a game from the database 
Loading a game from the database is easy, just double click on the line containing the game 
you want to view and the game is loaded. The database window is automatically minimized, 
the moves list window contains the moves and the chessboard is moved to the start of the 
game. You can now navigate through the moves in the game, continue playing the game etc.  
When the database contains many games, you may want to search only part of the games. 
For this purpose select the Games filter function. In the games filter dialog you can set 
various search conditions. 

 
The Date range option holds a number of ways to select games and accepts the following 
formats: 
 DD/MM/YYYY (Day / Month / Year) 
 *All games played on that specific day. 
 ??/MM/YYYY 
 *All games of a certain Month. 
 ??/??/YYYY or YYYY 
 *Games from an entire Year. 
 DD/MM/YYYY - DD/MM/YYYY (from - to) 
 *Games played in the time span. 
 YYYY - YYYY (from - to) 
 *Games played in these years. 
Mixing formats is also possible, an example; 1922 - 31/6/1928 
Searching by date value through the database does not use a key or index. The files will be 
searched sequentially and in case of large files may take up longer periods of time. 
Searching a database on date is usually not a ‘key search’ and depends on the type of 
database in use. In most cases the database needs to be read through sequentially which 
may take more time for larger files. 
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+#Saving a game. 
You can save game or position, after entering the game details, in a database. Use the Save 
Game or the Save Game As function from the File menu. The first function overwrites a 
existing game in the database. If there is more then one database open, the program asks in 
which database to save to game.   
In the “Game details” dialog a great deal of information can be entered and attached to a 
game. 
 
There are two types of fields: 
 Key-fields, these contain text that can be searched with the Filter function. Key fields 

are: 
  Opening 
  User key 
  White players name 
  Black players name 
 Information fields, these are all the remaining fields where additional text can be 

typed. It is recommended to always use the comments field, since they can be used to 
describe a game as YOU prefer it. 
Games can be saved Normal or Compressed. The normal format saves the time played for 
each move, using eight bytes per move against one byte per move for the compressed 
format. The compressed format uses a different move coding, taking a (very) little bit more 
time to regenerate a game. Since disk-space is valuable, use the compressed format where 
possible. 
 
Alternatively, since version 5.4 it is possible to save a game directly in a PGN file without first 
opening it as database. The Save Game As PGN funtion from the File menu directly stores 
the current game in a PGN file, overwritting or creating a new file. The Append Game To 
PGN menu appends the current game at the end of the selected PGN file. To read back 
games saved this way it is still necessary to open the PGN file as database. See previous 
section. 
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+#Drag and drop 
A game can be copied or moved. With the left mouse button you can drag and drop a game 
on various places. First select one or more rows containing the games of interest. You can 
select a row by clicking on the most left column. Now move the cursor slightly until it changes 
shape, now start dragging by a left mouse click. Dropping the game on the chessboard or the 
moves list loads the game.  Dropping on another database window moves the selected 
games. By holding the <Ctrl> key the games are copied instead of moved. 
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+#Exporting the database 
The program offers the possibility to move/copy multiple games from one database to another 
in a single step. First you open the database you wish to export from (read). Next, choose 
Export from the File menu, which presents the following window:  

 
In the destination field you type the name and location of the file you want to receive the 
games in. To easy locate an existing file, use the … button. 
By using the Filter button you may export only a selection of games meeting the filter key 
values. The filter is equal to the one used to list Games as described in a previous chapter. 
Depending on the source type of database you may have the option to remove from source. 
This will delete the games you copied to the other database. 
Note that not all database formats can be used for export/import. 
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+#End game databases 
Initially the end-game-databases supported by the Lokasoft standard engine are mainly made 
by Ken Thompson, an American Pioneer in this area who already in 1975 performed 
revolutionary study and tests. In that period he developed endgame databases with 3 and 4 
piece endgames. The endgames using 5 pieces where developed later on. In other words, 
endgame databases are around a long time but it took a while before (commercial) programs 
make use of them. This is mainly due to the large size a database may take. 100 Megabytes 
are not unusual for a single database file. Now that CD-ROM are accessible to almost 
everyone, the endgame databases find their way to the public through this medium. 
Considering the size of this multitude of files (currently 4 CD’s full!) a fast CD-ROM player 
makes sense. Quad or six speed drives are recommended although single and double speed 
will work. 
 
Since a few year the Nalimov endgame table bases are standard supported. Advantage of the 
Nalimov endgames are they give the distance to checkmate whereas the Thomson tables 
give the distance to conversion. 

Definition 
An ‘End game’ position “calculated up to mate or draw is about the shortest description we 
can give but it does not cover it in full. simply looking up the best variant for a certain position 
seems the way to reach the end. There are however, many ways (longer) to get to the end. 
An end game database is therefore build differently. Each position has the number of moves 
that will lead to “conversion”. Conversion means where the material or amount of material 
changes. In other words; when a piece is removed from the board or promotion occurs. After 
conversion a new end game situation exists and requires a different database to access. 
When you provide the best counter-play against the database the “finale is as far as 
possible”. When played ‘worse’ than opposed the end will be nearer! 

5 Piece end game 
Such an end game has of course the black and white King plus three other random pieces. 
Theoretically all these positions can be calculated till the games finale. This is a tremendous 
job and till date only the most relevant kind of piece combinations have explored. Its only a 
matter of time before the others appear. 
In a number of cases we must ignore the 50-move rule to come to an end. This is not 
according to accepted Chess rules but from a scientific point of view, interesting. The program 
offers the option to ignore the 50-move rule to enable you exploring several end games that 
require such. Note: Not all engines support this function. 

Using the end game database 
In order to use the (Ken Thompson) databases you’ll need to turn on this feature through the 
Chess brain options. Additionally you will need to define the drive(s) and path(s) where the 
databases can be found using the Advanced.,. engine options. 
Note that the program may be delivered with or without End Game CD-ROM’s depending on 
your supplier and price! The Internet distribution does NOT come with the CR-ROM’s 
Place the CD-ROM in the CD player. In case you have multiple CD-players you may use 
multiple end game CD’s simultaneously. When you have a CD-ROM Jukebox do NOT use 
multiple End Game CD’s, the swapping of discs takes too long for correct functioning. Further 
action on your behalf is not required, except moving the game to a 5-piece position of 
course... 
From that moment on, when it’s the computers turn, the position is checked to be present in 
one of the databases. If so, you are prompted to put the appropriate CD into the drive if not 
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already present. Next the database is queries for the best move. During the search you may 
be asked to put in another end game volume since the position may convert into a different 
game. 
When the position is present in the database, the Statistics window will show it. It will occur 
that multiple best moves exist for a certain position. Using the Next Best feature you can 
evaluate these paths. The Statistics window indicates the presence of next best moves where 
variant moves are between brackets. 
Since the database is constructed to seek for the shortest distance to conversion in the first 
place and mate in the second, it may occur that mate can be reached sooner than the 
database will show! End games where a pawn (7th row e.g.) has an important role are good 
examples. 
  

Nalimov table bases 
What has been said about the endgame databases from Ken Thompson, in general also 
applies to the Nalimov table bases. It is recommended to store the table bases on a fast hard 
disk. The Nalimov table bases are also configured in the Advanced.,. engine options page. 
Multiple paths may be given separated by semi colon. No matter what path you fill in, the 
directory where the program is installed is always searched first. Standard the program 
comes whit all the 3 piece endings ( K+K+piece). Other endgames can be downloaded from 
the Internet. Check our website for the location. 



+#The Internet functions 
The program has the option to play chess through the Internet. There are two methods, one is 
to make use of one of the public chess servers, the other method uses the build in function of 
The program to play to someone else using the same program. Next a tutorial using both 
methods is given. Both methods assume you already have a valid Internet connection and 
you are not behind a firewall or proxy server. In other words you have a transparent Internet 
connection. 

+#Using a Chess server 
On the internet there are many free chess servers active, the function of a chess server is to 
bring two people together in play a game, moves send by one player are passed on to the 
other player. A chess server has many more functions, It can keep track of your ELO rating, 
allows you to observe other people games, you can see who is online, challenge people for a 
match etc. To make maximum use of a chess server you have to register yourself, you will get 
a nickname and a password. If you are not registered on most chess servers you can still play 
games but they won’t get rated. 
To start using a chess server you must take the following steps: 
• Create or open an Internet console, the Internet console contains all the settings to 

communicate with a specific chess server. The program contains a number of pre-
configured Internet consoles. The Internet console has two panes, the top large one 
contains the responses received from the chess server, the bottom small pane allows you 
to send you own commands. 

• Connect to the Chess server using the Connect button from the Internet console. Fill in 
your name and optional password. When connected you should see the welcome screen 
of the chess server. Note: If you have never logged in before, leave the password field 
blank. 

• Now you can use the various commands from the Internet menu. You can find out who is 
online, which games are playing, challenge someone for a game etc. 

• Be prepared, someone may challenge you as well, if this happens a popup dialog 
appears with all the challenges received so far. You can accept or decline a challenge. If 
you accept you can just start playing the game.  

• When your finished, use the disconnect button to disconnect from the chess server. 

+#Using a direct connection 
It is also possible to play without a chess server, in this case you have a direct connection to 
someone also using the program. One of the players need to take the role as server, while to 
other takes the role as client. Further operation is similar as when using a chess server. 
Next a step by step procedure is given for both the server as the client role. 

Server role 
• Create or open an Internet console, make sure to set the Console type to ChessPartner 

server. This can be done in the console properties. 
• To activate the server, press the connect button, fill in your nickname. The console 

window will show << Server ready on port: 5000 >> 
• At this point the server is ready to receive a connection from the remote client. One note, 

the remote client needs to know the computer name or IP address of the server. In case 
of a dialup connection this IP address may be different every time. To find out your 
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current IP address use the dialup monitor, this can be found somewhere under details 
(check your OS manual). In windows 95/98 you can also use the winipcfg program, just 
run it from the ‘Run’ option below the Start button. 

Client role 
• Create or open an Internet console, make sure to set the Console type to ChessPartner 

client. This can be done in the console properties. In hostname file in the computer name 
or IP address of the remote player. 

• Press the connect button to active the connection. Fill in your own name. If all goes well, 
you should see the welcome screen from the remote server, like : << Chess partner 
welcomes 
you>>. 

• Now there is a direct connection between the two programs, you can chat by just typing 
some text in the console windows and pressing enter. 

• To start a game use the Challenge command just as you would do when you are 
connected to a real chess server. If the remote player accepts the challenge the game is 
started. 

Using ICQ 
It is possible to find out the remote player’s IP address when both players have an ICQ 
account, for instructions how to do this check out the ICQ documentation. 
Also it is possible to start the program with some command line options to pass the IP 
address.  
 
Command line parameters: 
 
CP5.EXE  Filename [options] 
Filename should be the name of a saved Internet console configuration, e.g. “icqfriend.fic” . If 
the filename contains spaces, you must enclose it in quotes. 
 
The following options can be used: 

/Host=name[:port] 

With this option you can specify to which remote computer to connect. The name can be a 
hostname or a IP address plus an optional port number. 

/HostType=n 

This option specifies to type of host to connect to, the n parameter can have to following 
values: 
0 - Internet Chess Server 
1 - ChessPartner Client 
2 - ChessPartner Server 
 
/Name=username[:password] 
Here you can pass the user name that is sent during the logon sequence. 
 
/HostOptions=n 
Additional options can be given, the value n are a number of bit flags. 1=computer plays, 
2=auto challenge accept. 
 
Sample ICQ configuration: 
 
 
External Application Executable: 
c:\Program files\Lokasoft\ChessPartner5.0\CP5.exe 
Command Line: 
/Host=%i:5000 /HostType=1 /Name=%h 



 
External Application Server Executable: 
c:\Program files\Lokasoft\ChessPartner5.0\CP5.exe 
Server Command Line: 
/Host=localhost:5000 /HostType=2 /Name=%h 



0 +#Chess server commands 
This section gives an overview of the various Chess server commands. Not all of the 
commands are always available, this depends on the context, whether you are connected to a 
chess server or to a remote ChessPartner. 
To send a command, just type it in the console window and <Enter> to send. 
For the most common commands there are easy to use menus available. For the less used 
commands you may have to fall back to typing the command in the console window. 
To find out what commands a specific chess server understands, type the help command. For 
help on a specific command the syntax is usually: help  xxx Where xxx is the command you 
want help on. 
Some of the commands can be accessed by right clicking the mouse on the Internet console, 
the menu depend on the context where you have clicked. If you clicked on a name in the list 
one of the context menus would be: Challenge player 

Games 
The games command returns a list of games in progress, there is a dialog available from the 
Internet menu, this allow you to set various options. 

Observe 
With the observe command you can observe the moves of a game in progress. After observe 
type the name of one of the players of the game you want to observe. The list of games can 
be retrieved with the games command as discussed before. 
The moves list with be filled with moves from the point you start observing, thus earlier moves 
are not listed. 
Use the unobserve command to stop observing the game. 
There is an easier way to observe a game, first ask for a list of games, then right click on one 
of the player names in the list, the drop down menu has the observer command. 
If you don’t want others to observe the games you are playing you can use de command: set 
private 1. To cancel this: set private 0. 

Who 
The who commands gives you a list of logged in players, if there are more player than fit on 
one screen, use the next command to get the next screen. 
The who command as many options, we won’t describe them here. The program has a 
dialog, which allows you to use the most common options of the who command. The dialog 
can be found under the Internet menu. 

Sending and receiving game requests 
To challenge someone for a game use the following procedure:  
• First check who is available for games using the who command. 
• Right click the mouse on the player you want to challenge, from the drop down menu 

select the Challenge command. This sends a challenge with default parameters. If you 
hold down the <Shift> key while mouse clicking you will get a dialog which allow you to fill 
in some parameters. 

• If the remote player accepts the challenge you can start to play. 
Other may challenge you as well, when this happens a dialog pops up with the challenges, 
you can either accept or decline the challenge. It is also possible to do a counter challenge 
with different parameters. 
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Playing the game 
When you have accepted a challenge or some accepted you match request, the game can 
begin. Moves can be played as usual, just move the pieces on the board. Moves from your 
opponent are automatically played on the board. 
During the game there are a number of commands available. 

Resign 

The opponent wins the game; no answer from opponent is required. 

Draw 

Send a draw offer to the remote player, the opponent can accept or decline the offer. When 
there is a legal draw, e.g. 50 moves rule or 3-fold repetition the chess server automatically 
accepts the draw offer. 

Adjourn 

Adjourns the game. The server saves the game. You can continue the game at a later time. 

Flag 

The opponent has lost on time, this command must be send to claim a win. The chess server 
verifies the claim. 

Chat 

You can chat with others on the chess server. With the ‘say’ command you can send a 
message to your current opponent. If you are not playing a game you can use the ‘tell’ 
command. E.g. 
 
Say Great match, huh ? 
Tell knight what is your personal rating ? 
 
When you receive a message is looks like this: 
 
<player> tells you <message> 
e.g. 
Knight tells you My rating is 2234 
 
When you are a registered player and don’t want messages from non registered players you 
can use the ‘set tell 0’ command. ‘set tell 1’ accepts messages again. 

Stopping 
To stop the session with the chess server you can either type the quit command from the 
console window or click the disconnect button from the toolbar. 

Letting the program play on the servers 
Instead of play the moves your self; it is also possible to let the computer play the moves. 
Normally this should only be done if you are logged in using a computer account, generally it 
is considered cheating when you let the computer play using a normal account. 
In order to let the computer play you have to check the ‘Computer Plays’ option in the Internet 
console properties. You can only change this setting when you are not connected to the 
server. If you want to play fully automatic you can also check the ‘Automatic Challenge 
Accept’ option. 
 
In addition the Engine Active option must be set, however this option can be enable or 
disabled during internet play, advantage is you can now play togheter with the engine.  



Be aware when the Computer plays option is on this is always reflected in your interface 
variable independent wheter the engine is active or not. 
 
The contents of the ‘Auto Seek Command’ field is send at the end of each completed game, 
normally you would use this to place new seeks. Multiple commands can be issued by 
separating them by \n 
 
New is the Max rematch field, by entering a number you can limit the number of auto played 
games against the same opponents. This is usefull for unattended play. 



+#Advanced options 
This section gives a description of the more advanced options. 

+#Editing advanced options 
Within the program many parameters can be changed. Many off these options can set with 
options dialog box, which can be found under the Extra menu. 

+#Saving current settings 
Each time you start the program, the application and its Windows appear at a certain location, 
a specific level-of-play, and with player’s names, etc. These values can be changed during a 
game session with the various menus and dialogues. To prevent you from entering those 
preferences over and over again, you may save them as standard settings. Use the Save 
setting function from the extra menu. 
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+#Chess engine options 
On this page you can set the various options for the chess engine. 

Permanent brain 
This option defines whether or not the brain uses the time when the opponent is thinking to 
calculate moves. In other words the computer looks up a best move for the opponent and a 
countermove. 

Transposition tables 
The program can make use of so called transposition tables that will speed up calculations 
considerably for end games. It will also allow bigger search depths to be reached. It is 
recommended that you leave this setting on for all levels, unless you feel the program is much 
too strong for you... 

Use endgame databases 
To let the program make use of the end game databases you must check this marker. In case 
you don’t own any end game CD do not turn it on. And, in case you rather have the chess 
engine calculate the moves in the final stages of the game, you can also leave it off. In case 
you do want to make use of the end game databases read the topic in this manual first. 

Ignore 50 move rule 
Usually the chess engine uses and applies the 50-move rule. As discussed in the end game 
database topic, are circumstances possible where this rule is not wanted. Specific end -game 
databases require ignoring the rule or the game’s end is not in reach. To view such situations 
this option is present. 

Advanced 
The advanced button calls up a dialog, which is provided by the chess engine, as it is 
possible to use different chess engines the actual functions of this dialog, varies between 
different chess engines. 

Engine 
This option allows you to choose a different chess engine, after clicking the button a list of 
available engines is displayed. 
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+K$#The WinBoard adapter 
The program comes with a winboard adapter that allows the use of winboard or UCI 
compatible Chess engines. The following pages give more information about the use and 
configuration of the winboard adapter. 
 
To use the adapter Select Extra -> Options on the Chess engine tab click the Engine button, 
there should be an entry "Winboard adapter" in the dropdown list. This selects the plug-in 
module. You may get an error message asking to edit the engine profile, responding yes 
brings up the plug-in profile selection dialog. Select crafy or gnuchess, you must edit the 
profile for the location of crafty or gnuchess. 
In this release the profile is stored in a simple text file, each engine profile start with a line 
[name] where name is CRAFTY, GNUCHESS, etc. The file is located in the windows directory 
and called: 
 
ENGINEEXT.INI 
 
Make sure to save the settings! 
 
Of course you first have to install the various winboard engines. It is recommended to install 
each engine in its own directory below the engines directory in the installation directory e.g. 
 
C:\Program Files\Lokasoft\ChessPartner\Engines\Crafty 
C:\Program Files\Lokasoft\ChessPartner\Engines\GNUCHESS 
etc. 
 
 
 
The ENGINEEXT.INI file contains a number of sections. 
There is one section for each engine. A section starts with the engine name in between 
square brackets e.g. 
[Crafty] 
 
Below this line there are a number of parameters that can be set, the most important are the 
first four: 
 
Console=? 
 
If console is set to 1 all commands that are send to the engine are displayed in a console 
window. Set this to 0 to hide the console window. 
 
Logfile="engineext.log" 
 
If a filename is given all commands are also saved in this file, useful for debugging. If left 
blank no logging is done. 
 
EngineDir="" 
 
EngineDir specifies the directory where the engine is to be runned from. If left blank the 
directory of the chess engine is used. 
 
EnginePath="eninges\crafty\wcrafty.exe" 
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EnginePath is the command line used to start the engine, is may be an absolute or  relative 
path. In case of a relative path the installation directory is used as base. 
 
Furthermore there are some parameters to control what kind of commands are send to the 
engines. In most cases it is not necessary to change any of these. A command string can 
contain \n which is the same as enter typed from the command line. In this way it is possible 
to send multiple commands to the engine. 
 
Options=n 
 
The Options keyword controls various aspects of the adapter. The following options are 
defined:   
1 – Invert score 
2 – Send time/otime before engine is instructed to compute a move. 
 
Options=2 - Sends time/otime 
Options=3 - Same + score invert. 
 
EditMode=? 
 
Editmode 0= use editstring, followed by the pieces e.g. GNUCHESS, 
1=use setboard + fen e.g crafy mode 
 
 
InputMoveDelay=30 
 
This specifies the time in milliseconds to wait after a move has been received from engine but 
before passing it on to the GUI, is intended to receive possible end of game conditions like 
checkmate, resign etc. 
Default is 30 
 
 
OutputMoveDelay=0 
 
This is the minimum time to wait, before sending another move.  Default is 0 
 
ExitString="quit\n" 
 
This string is send to exit the engine. 
 
EditEndString=".\n" 
 
String sent to end the edit board mode. 
 
SwapColorString="c\n" 
 
This string is send in edit board mode to swap the colors. 
 
EditString="edit\n#\n" 
 
This string is send to start the edit board mode. Is only used when the edit mode is 0. 
 
ForceString="force\n" 
 
The command is send to the engine to set the engine to play neither color ("force mode").  
Stop clocks. The engine should check that moves received in force mode are legal and made 
in the proper turn, but should not think, ponder, or make moves of its own. 
 
UndoMoveString="undo\n" 
 



If you have Rebel Tiger take bake moves, it sends this string for each move to takeback. 
Before sending this string it firsts sends the ForceString. 
 
ColorStringw="white\n" 
 
Command send to have the engine play the white moves 
 
ColorStringb="black\n" 
 
Command send to have the engine play the black moves. 
 
ComputeString="go\n" 
 
Command send to start the engine thinking it's best move. 
 
MoveNowString="?\n" 
 
This command is send to the engine to force it to play a move right now. 
 
NewGameString="new\nrandom\nponder on\n" 
 
This string is send when a new game is started. You may want to modify this string to set 
some additional options. You make sure the engine is ready to start a new game. 
 
InitString="xboard\nnew\nbeep\nhard\npost\nponder on\n" 
 
This string is send when the engine is first loaded. You may want to add some additional 
options; important is that the engine is working in a winboard compatible mode. 
 
NameRev="Crafty v15.14" 
 
This string is displayed in the engine properties page and also show when you play the 
engine on the Internet. Fill the name and version of the engine. 
 
PonderOn="hard\n" 
 
This string is send to enable pondering, if this string is specified you must also have a 
PonderOff key. 
 
PonderOff="easy\n" 
 
This string is send to disable pondering, if this string is specified you must also have a 
PonderOn key. 
 
SetAnalyseMode="analyze\n" 
 
This string is send to set the engine in analyze mode, if this string is specified you must also 
have a ExitAnalyseMode key. If the engine does not support the analyze mode leave these 
keys blank. 
 
ExitAnalyseMode="exit\n" 
 
This string is send to leave the analyze mode, if this string is specified you must also have a 
SetAnalyseMode key. 
 
 
Then there are a number of level strings, these are used to map the Rebel Tiger levels to the 
level commands understand by the engine. 
 



Rebel Tiger has 7 kinds of levels, each kind of level has some parameters with it. For each 
kind of level you can define a string with parameter replacement that is send to the engine. 
 
The following parameters can be inserted: 
 
 
%1 = First search depth in ply's 
%2 = Second search depth in ply's 
%3 = First time check in seconds 
%4 = Number of moves until first time check 
%5 = Second time check or time increment in seconds 
%6 = Number of moves for 2nd time check 
%7 = First time check in minutes (Same as %3 but then converted to minutes) 
%8 = First time check remainder seconds (Use in combination with %7) 
%9 = Second time check in minutes (Same as %5 but then converted to minutes) 
%10 = Second time check remainder seconds (Use in combination with %9) 
 
Level0=level 1 9999 0\nsd %1\n 
 
The Level0 string is send when a fixed search depth level is selected. The %1 parameter is 
the requested search depth in plies. 
 
Level1=sd 29\nlevel %4 %7 0\n 
 
This string is send when a tournament level is selected. The %3 and %4 parameters are for 
the first time check, the %5 and %6 for the second time check. 
 
Level2=sd 29\nst %3\n 
 
String is send when a fixed time per move is selected; the %3 or %7 and %8 parameters 
contain the selected time. 
 
Level3=level 1 9999 0\nsd %1\n 
 
This string is send when a search for checkmate level is selected. The %1 parameter is the 
selected depth. 
 
Level4=sd 29\nlevel 1 %7 %3\n 
 
This is send when a level with a average time per move is selected. The %3 or %7 and %8 
parameters contain the selected time. 
 
Level5=sd 29\nlevel 0 %7 %5\n 
 
Level with a time increment after each move is made ("fisher clock") The %3 or %7 is the 
base time, the %5 parameter the time increment. 
 
Level6=level 1 9999 0\nsd 29\n 
 
This string is send if the infinite time level is selected. 
 
Known problems. 
 
For a number of features Rebel Tiger relies on functions in the chess engine, e.g. the opening 
book display and some others. These functions are not present in other chess engines so 
these functions are disabled. 
 
Testing has mainly been done using crafty. 
 
On occasions the chess engine does not exit. 



 
Not all levels are interpreted correctly. 
 
 
DISCLAIMER 
THE WINBOARD ADAPTER IS UNSUPPORTED SOFTWARE. WE HAVE INCLUDED IT IN 
THE HOPE SOMEONE FINDS IT USEFULL. AS IT’S OPERATION RELIES ON SOFTWARE 
OUTSITE OUR CONTROL WE CANNOT MAKE ANY WARRANTY OF ITS PROPER 
FUNCTIONING.  
 



+#General options 
General options are those that influence the programs behavior at one or multiple places. The 
option can be set in the General page of the options dialog.  
 

Sound 
The computer can produce several sounds to get the players attention for various situations; 
e.g.; Players turn, Chess-messages, faults, etc. 
Sounds can be simple "beeps" that catch the attention but do not irritate, or even specials like 
speech! If you do not want any sounds, turn off the check-box. 

Speech 
The program offers some messages as WAVE playback. It is only available if you use a 
device (and driver) that supports WAVE files such as a SoundBlaster or compatible card. 
Special sounds can be activated by setting the check-box. The setting of Sound effects must 
already be on. Several voices are available, these can be selected with the drop-down box. 

Autosave last game 
Enabling this option provides you with the last position and complete move list of the game 
played upon exiting the program. This prevents you performing save-and-load steps between 
sessions. 

Short notation 
When checked the short notation is used for displaying the moves. 

Figurines 
Instead of the usual letter symbol, a picture is used in displaying the moves. 

Columns 
The moves list can be either displayed as a stream of text, or it can be displayed in two 
vertical columns. 

Showing annotations 
When this option is checked the annotations are displayed together with the moves in the 
moves list.  
 
Show opening name 
The name of the opening is shown. 

Show all game details 
All the game details are shown at the top of the moves list. This includes things like; player 
names, tournament, round, etc. 

Print annotations 
The annotations are printed. 
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Print diagrams 
A diagram of the current position is printed with the moves list. 

Print with figurines 
The figurine font is used in the printed moves list. 

Print in columns 
The moves of the game are printed in two vertical columns. 



+#View options 
In this page the various options affecting the display can be found. 

Statistics options 
There are a number of options that control the display of the statistics window. 

Current move 

The move currently being analyzed is displayed. 

Show thinking during players turn 

The activity of the permanent brain is shown. 

None 

No variations are shown 

Best only 

Only the best variation found so far is displayed. 

All 

All best variations found are displayed in a scrolling list. 

Histogram options 
Here you can control the display of the histogram. 
You can choose between a bar and line graph style of display. Also the point of view (White 
or Black’s) can be selected. It visualizes the path the score follows and if it looks good for 
White or Black.  
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+#Chessboard options 
The chessboard options can be found in the Chessboard page, here the options that affect 
the display of the chessboard can be found. 

Field colors 
Use the buttons to adjust the colors of the white and black fields. This option only works when 
selected piece set does not make use of a bitmap picture of a chessboard. You can use the 
hatch option to have the black fields hatched. 

Sliding pieces 
When the program is moving the pieces on the chessboard you have the option to change the 
speed at which it happens. The slide bar allows you to increase or decrease speed and is 
also related to the speed of your machine. The ‘fastest’ possible setting performs no 
animation at all, piece are move from - to at once. 

Show board coordinates  
Many Chess players know the board by heart. For beginning players it may be handy to 
locate the fields of the Board with the help of an index border. Horizontally the letters 'a' 
through 'h' are displayed and vertically numbers '1' through '8'. Especially when the Board is 
rotated locating fields is not so easy. Check the box with the appropriate name. 

 
 

Smart move 
If this option is selected, only a single click on the destination square is needed to make a 
move. If more then one move is possible a dropdown menu is shown. 
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+#Adjusting the Chess Clock 
Using the Clocks... dialogue from the Games menu, the current time settings can be 
changed. 
 During a Computer-Chess tournament, some time gets lost due to the fact that the operator 
must perform the moves as well as other handling. To compensate for this lost time, it is 
necessary and allowed to adjust the Clocks. Also, in some situations, the tournament 
organization has the right to set Clocks. Usually the values provided by a mechanical Chess-
Clock may be copied into the electronic Clock. 
The dialogue continuously shows the updated Clocks in the right-hand-side boxes when the 
game is not paused. New values can be entered in other edit-fields. 
In tournament levels, the time displayed is the time left to play. In other cases it reflects the 
time played so far! 
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+#Selecting a different piece set 
The program comes with a choice of piece sets peek or select them with the Select piece set 
dialogue below the View menu. The dialogue shows some of the pieces in the set in a list 
box.  
Because the piece sets have been created in different sizes, they look at their best in their 
original size. Select the Optimum Size from the Windows menu to re-size the Chessboard 
such that the piece set looks at its best! 
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+#Choosing a graphical Clock 
As mentioned before the Chess clock can be displayed as a digital or analogue clock. The 
analogue clock is a graphic implementation of the mechanical clock, where you may choose 
from some pre-defined graphs.  
Selecting a clock is similar to selecting a piece set, but the size of the clock window is 
automatically adjusted. Re-sizing the clock window may distort the image and can be restored 
using Optimum Size from the Windows menu. 
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+#The opening books 
The program allows you to maintain your own set(s) of openings next to, or in place of the 
main book supplied with the program. Multiple user books may exist and can be active at the 
same time. Switching between user books can done at any time during the game. 
Various functions related to the user book can be found below the Book maintenance sub 
menu located under the File menu. It is also possible to let the selected Chess engine handle 
it’s own book, in that case some of the functions described below are not active. 
Some additional options are available from the book moves window by selecting the books 
tab. 
The next topics describe each book function. 

Open a book 
To make use of an existing user book, it needs to be opened. Use the Open book menu 
choice to do so. With the help of a (common) dialogue, a file can be selected and a short 
description of the book is shown. By pressing OK the book is loaded and can be used by the 
program.  
There can be a maximum of four books open at any one time. 
NOTE: User books have the .BK extension. 

Creating a new user book 
By choosing New Book a dialogue allows you to enter a filename. A second dialogue allows 
you to enter a description of the book and the type of book. The filename must have the .BK 
extension and will be automatically selected as the active user book. 

Closing a book 
To close a book, select the books tab from the books window, and then select the book you 
want to close and click the X button. 
 

Changing the book priority 
The opening books are consulted in the order they are listed in the books window, to change 
the order, first select to book you want to change, and then use the arrow buttons to move the 
book either up or down. 
 

Book properties page 
The book property page contains how the opening books are used: 
 
The book handling options determine how the book is handled, choices are: 

• None checked - No book is used. 
• Use GUI books - The GUI is responsible for handling the opening books. 
• Use Engine books - The current selected chess engine is responsible for handling the 

opening books. 
If both GUI and Engine books are checked, the GUI books are always consulted first. 
Only when there are no more moves in the GUI books, the engine books are used. 

 
The Move distribution option control the way book moves are selected: 

• Random - Move selection is strictly random 
• By learned scores - Moves whit a high learned score will be played more often then 

moves with a low score. 
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• By times played – Moves that are played more often have a higher chance of being 
played. 

 
When Priority Select is checked only moves from the highest priority book are played, only 
when the highest priority book has no more moves, the next book is consulted. 
 
The Variation slider controls how varied the selection is, moving it all to the left means only 
the best moves are played, which can get a bit boring. When moved to the right it can also 
play moves, which may be less optimal. The middle is the recommended setting. 
 
The Learning slider controls how much use of the learned information is made, to left means 
no use of learned information is made, to the right a single lost game can be enough to avoid 
playing the variation again. 
 

Adding opening variants 
Variants, or even complete games, can be added to the book. Proceed as follows: 
• Play the variant up to and including the position that has to be added to the user book. It 

is not required that the variant starts from the initial (new game) position! 
Select Add variation from the Files - Book maintenance menu. 

• The dialogue now shows the variant, you may decide whether White, Black or both can 
play the variant. You may also set a score for the variant with a value between -127 and 
+127 as opposed for White.  

• Select the proper book from the drop down list. 
• Now press the Add button to add the variant to the current user book. 

Deleting opening variants 
The procedure to remove variants from the user book is similar to adding them: 
 
• Play the variant up to the position that has to be removed. 
• Select Delete variation from the Files - Book maintenance menu. 
• The dialogue shows the variant. 
• Select the proper book from the drop down list. 
• Press the Ok to remove the variant from the selected book. 
• If the variant overlaps another variant, only the non-overlapping part is removed. This will 

prevent the other variant from being damaged! 

Updating book moves 
It is also possible to directly edit various properties of the individual book moves. To do this, 
right click on the moves in the book moves window, and select the Update moves menu 
function. 
A dialog with a list of moves will be shown, each move can have a number of attributes, the 
score can be a number between –127 and +128. The priority attribute determines if the move 
is playable.  0=don’t play, 5=best move, 3=normal move. 
Not all books support all priority. 



+#Customizing the menus and toolbars 
It is possible to customize the toolbars and the menus. The customize functions can be 
accessed from the Customize function under the Extra menu. 
The property page contains several tabs to customize the menus and tool bars. Most of the 
functions are accessible using drag and drop. Once in customize mode, buttons and menus 
can simply be dragged and dropped to your liking.  
Once the setup is to your liking it can be saved as part of a layout. 
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+#The Clipboard 
The program allows some uses of the Windows clipboard. These functions can be found 
below the Edit menu. The current moves list, or graphical Chessboard can be copied to the 
Clipboard. The move list can be copied with or without the annotation texts. The Clipboard's 
contents can then be used by a text editor to produce reports, etc., in addition of the build in 
print functions. 
The usage of the Clipboard in reverse order is available too! 
By putting a move list in ASCII format onto the Clipboard, with NOTEPAD for example, it can 
be imported move-by-move. Choose the Paste selection It will only be available for selection 
if an ASCII text format is available on the Clipboard. The notation offered can be either short 
or long, where the latest has preference since short notation may cause ambiguity. Only 
moves may be listed, optionally preceded by move number. Annotations, etc. are not 
supported! Copy a move list to the Clipboard and study the format from the Clipboard by 
pasting it into a NOTEPAD as a simple Clipboard format.  
It is also possible to have a game in full PGN format on the clipboard, this is automatically 
handled. 
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+#Macros 
The macros feature was originally developed to measure the strength of the program in an 
automated fashion. A script can be used to evaluate a great number of positions without the 
need for human intervention. The macro functions can be found in the Extra menu. 
A script is basically an ASCII file consisting of VB (Visual basic) commands.  Currently the 
documentation for the macro functions is not yet available. 
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+#Context menus 
To make popular features quickly available they are connected to the related Window. It’s 
accessible by clicking the right mouse button while the pointer is in the window area. The 
menu will pop-up nearby the pointers vicinity. 
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Support programs 



+#Book conversion program 
Opening book conversion application 
 
This application is intended to convert native or PGN databases to the opening book format. 
It is possible to convert multiple databases into a single book file. 
The maximum number of moves from each game to add can be set. Selecting a high (e.g. 
999) number will add the whole games to the book. 
If desired only the white or black moves can be added. 
 
Warning! Depending on the number of games to convert, the conversion can take quite some 
time. The average conversion speed is a few games per second, thus conversion of 100000 
game may take as much as 13 hours or more. 
 
Also make sure there is enough free disk space available, a book file takes much more space 
then a database. Average 10-20 bytes per position is used, so to create a book from the first 
15 moves of 100000 game would take: 100000 x 15 x 2 x 10 = 30000000 = 30 Megabyte  ! 
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+#Database conversion program 
The installation contains an application to convert and merge databases, this program runs 
from a DOS command line, to operate: 
 
Start the program from a DOS prompt: 
Usage: 

BATCHCVT [options] indatabase outdatabase 
Options:  /s - traverse sub directories 
indatabase - input database(s) wildcards allowed 
outdatabase - output database, must exist 

 
e.g. BATCHCVT /s *.PGN BIG.LDB 
This command converst all PGN databases into one big native database 
 
Note: If you just want to convert a single database, use the Export function from the File 
menu. 
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+#Learn to play Chess in 30 minutes 
Introduction 
Chess is a fascinating game. It originated very long ago and is played nowadays by millions of 
players. Almost everybody has played a few games in his or her life and knows about the basic 
rules of chess. In case you don't or want to refresh your basic knowledge, we offer you a small 
course about chess. Maybe you will be fascinated by the tactics and strategies involved and 
chess will become your greatest pleasure. 

The board 

 

The playing field consists of 64 squares, with 32 black and 32 white squares. It consists of 8 
rows, labeled 1 to 8, and 8 columns labeled a to h. The rows are called ranks and the columns 
are called files. The squares are given names: a1, b1, c1, d1, e1, f1, g1 and h1 on the first row. 
b1. b2, b3, b4, b5, b6. b7 and b8 on the second row and so on.. The field’s a1, a2, a3, a4, a5, 
a6, a7 and a8 form the a-file. h1, h2, h3, h4, h5, h6, h7 and h8 is the h-file. These names are 
used to make it possible to explain where the pieces are standing. 

Notation 
In order to record your games there is a special chess notation. In the notation the following 
symbols are used: K for King, Q for Queen, R for Rook, B for Bishop and the N for Knight (The K 
is already used for the King). For pawns no symbol are used. To describe a move first record the 
symbol for the piece, then the square it stands on, followed by the square it is going to. e.g. 
Qh3-e6. The Queen moves from h3 to e6. e2-e4. The pawn moves from e2 two squares ahead 
to square e4. Note that this is the long notation, there is also a shorter form in where only the 
destination square is given. 

The starting position 

                                                      
+ auto 
# cp_learnchess 



 

Place the board in front of you and make sure the is a white square (h1) on your right hand. 
Place the white pieces on the first row on the board: The King on square e1, the Queen on d1, 
Rooks on a1 and h1, Knights on b1 and g1 and the Bishops on c1 and f1. Place the white pawns 
on the second row in front of the pieces on the squares a2 to h2. Place the black pieces 
symmetrical at the opposite site at the 8th row and the black pawns at the 7th row. 
 • Observe the white Queen is on a white square, and the black Queen on a black square. 

The pieces 

The King 
This piece is the most important piece in the game. The King can move in any direction one 
square per move. For example: Kg4-g3, Kg3-f3 or Kf3-e4 
 • Observe that a King in the middle of an empty board can move to 8 squares  

The Queen 
The Queen is the most powerful piece. She can move horizontally, vertically and also diagonally, 
as many squares as she likes. For example: Qh5-a5. Qa5-c3 or Qc3-c6. 
 • Note that a Queen in the middle of an empty board can reach 27 squares. 

The Rook 
The Rook can move horizontally or vertically as far as it likes. For example: Ra3-a6, Ra6-g6 or 
Rg6-g3 
 • Check that a Rook on an empty board can go to 14 squares. 
 • Notice that in the starting position, the Rook is not allowed to move. 

The Bishop 
The Bishop moves diagonally. It always remains on the same colored square. For example: Bf3-
c6 or Bc6-a4. 
 • Check that we have a white white squared Bishop, a white black squared Bishop, a black 
white squared Bishop, and a black black squared Bishop. 

The Knight 
The Knight moves in an L-shape. 2 squares horizontally and 1 vertically or 2 squares vertically 
and 1 horizontally. A Knight is not obstructed by own or opponent's pieces. It jumps over them. 
For example: Ng1-f3, Nf3-e5, Ne5-d4 
 • Check that a Knight in the middle of an empty board can move to 8 squares. 
 • Notice that a Knight in the starting position is only looking to 3 squares. 

All Pieces can move forward and backward. None of the pieces except the knights can jump over 
other pieces standing in their way. 



The value of the pieces is considered to be: 
pawn 1, Rook 5, Knight 3, Bishop 3, Queen 9. 
A good player is expected to win if he is 2 points ahead in a favorable position. 

The Pawn 
In general a pawn moves forward one square. But when a pawn has not yet moved, it may also 
move two squares forward. The pawn can go only forward. Not as the other pieces go backward. 
For example: d2-d4, d4-d5 and d5-d6. 
 • Check that in the starting position White can choose between 16 pawn moves. 

Pawn promotion 
If a pawn reaches the other side, the pawn promotes. The player can choose if it promotes to a 
Queen, Rook, Bishop or Knight. Logically mostly a queen is preferred. A pawn promotion is an 
important goal to play for. 

An important difference between a pawn and the other pieces is, that the moving is different 
from capturing. The pawn moves forward vertically, but capture diagonally forward. 
For example: Put a white pawn on b2 and a black pawn on c3. The white pawn can move to b3 
or b4, or take the black pawn on c3. 

En Passant 
The 'En passant' (French for 'passing by') move is a special rule about a pawn capturing another 
pawn. If a pawn moves 2 squares forward and it stops next to an opponent's pawn on an 
adjacent line, then the opponent's pawn is allowed to take that pawn. It seems the pawn has 
moved only one square forward. This en passant taking is only allowed for the move, 
immediately following the previous pawn move.For example: put a black pawn on a4, and a 
white pawn on b2. The white pawn moves two squares ahead and goes to b4. Only now, the 
black pawn can take the white pawn. The white pawn is removed and the black pawn ends on 
b3. In notation: a4xb3 e.p. 

Attacking and capture 
If a piece can move to a square on which an opposite colored piece is standing, then the piece is 
attacking the opponent's piece. It is possible to move the first piece to the occupied square and 
remove the opposite colored piece from the board: the piece captures another piece. In the 
notation the symbol 'x' means capture.For example: If we have a white Rook on b3 and a black 
knight on b6. We can do the move Rb3xb6. The Rook moves from the square b3 and takes the 
piece on b6. 
A piece can not take a piece of its own color. In that case, the piece defends its own piece. 
Note: Capture is optional and not forced. In the starting position the pawns shield off the 
attacking possibilities of their own pieces. 
 • Check that in the starting position, not a single piece is attacked. 

 
Check and Checkmate 
When a piece attacks the opposite colored King, that King is in check. On the next move the 
king must be taken out of check. In notation the symbol '+' means check.For example: Ra1-
a7+. The Rook moves from square a1 to a7 and gives check. 
There are three ways to move the king out of check: 
1) Move the King to a safe square 
2) Capture the attacking giving piece 
3) Move a piece between the King and the attacker. 

The goal of the game is to checkmate the opponent's King. When a King is in check and connot 
be taken out of check, the King is in checkmate and the game has ended. 
 • Can you find the check possibility for White after the starting moves 1) e2-e4 f7-f5 ? 
 • Can you find the mate possibility for Black after 1) f2-f4 e7-e6 2) g2-g4 ? This mate is called 
Fool's mate, and is the shortest mate possible. 

Castling 
This is the only move when two pieces are moving: the King and the Rook. The king moves two 
(normally 1) squares to the Rook, and the Rook is placed at the other side (jumping) of the 
King.There are two kinds of castling: long castling and short castling. Often both players castle 
in a game. It puts the King in a safe(r) position, and it activates the Rook.For example: Start 
from the initial position: 1) d2-d4, e7-e6 2) Nb1-c3 Ng8-f6 3) Bc1-g5 Bf8-e7 4) Qd1-d2. Now 
Black is allowed to short castling: 4) ...   0-0. The King goes to square g8. The rook to square 
f8. Now White is allowed to long castling: 5) 0-0-0. The King goes to square c1 and the Rook to 
square d1. 



Castling is only allowed when: 
a) The King and the specific Rook have not moved. 
b) The squares between the King and the specific Rook are empty. 
c) The King is not in check (on e1). 
d) None of the squares the King, passes (on d1 or f1), are attacked. 
e) The King does not end in check (on c1 or g1). 

The Beginning 
Always White starts moving 1 piece, then Black on piece, then White, then Black, etc. until the 
game ends. Note that a move has to be made. There is no "pass" possibility. 
 • Check that in the starting position White can choose between 20 moves. 
 • Notice that White after having played the Kings pawn e2-e4, he can choose between 15 pawn 
moves + 4 Queen moves + 5 Bishop moves = 24 moves. 

The End 
win or draw 
The goal of the game is to checkmate the other King. When white checkmates the black King, 
White wins the game: 1-0. When black checkmates the white King, Black wins: 0-1 
When neither site is able to checkmate the other King, the result is a draw: 1/2 -1/2 

Draw 
A draw can be reached in different ways: 
- Stalemate. 
A player is not in check, but is also not able to move. 
- No mating potential. 
There is insufficient material to checkmate the other King. A King and Knight or King and 
Bishop, can not checkmate the other King. Note that a pawn can often  promote to queen. 
- Perpetual check. 
A player is able to continuously give check. The motive can be a worse position, or the inability 
to continue the attack. 
- Threefold repetition. 
The same position is reached for the third time with the same player moving  and with the same 
moving possibilities. 
- 50 move rule. 
If during 50 moves no pawn has moved AND no pieces have been captured, a draw can be 
claimed. 
- Draw agreed. 
In more complicated positions, after having done a move, a player can propose a  draw. The 
opponent may accept or decline this offer. 

Stategy 
As mentioned before, the goal of the game is to checkmate the opponents king. It obvious this 
goal not not be reached directly. Therefore there are some subgoals in the different phases of 
the game. 

The opening 
In this phase the goal is to develop your pieces. 

The middlegame 
In this phase you will de strengtening your position in order to prepare the attack on the 
opponents king. 

The endgame 
Now it time to go for the king. 

Ready to play 
You have just learned all the rules for playing chess and now you are ready to play a game of 
chess! We hope you enjoyed this course and that the explanations were clear enough for you. If 
you want to know more about some basic strategies in chess, you will notice your understanding 
will improve by playing, reading books, visit a chess club, play internet chess and learning with 
a chess program. Enjoy this royal game and have fun ! 

Next in this serie we will giving some stategic concepts.  
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